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PACO Y OPAC
1- Presentacion

Paco y Opac es un proyecto que trata una serie de animacion en formato
Flash, desde la idea inicial, pasando por todo el desarrollo conceptual,
audiovisual de un capitulo piloto, asi como la distribucion de la misma.

El publico objetivo de este producto se define bajo los siguientes
paradmetros:

- Edad: Adolescente-Adulto (~ 13-50 afios)
Es una serie que podria ver un nifio* (no incluyes chistes demasiado
salidos de tono) pero se supone que no captaria la gran mayoria;
aunque nunca se sabe (ahi tenemos el ejemplo de Los Simpson).
- Nivel de vida: Medio-Alto :
i. Conocimientos de Informatica: Para comprender los chistes y
navegar por la web.
ii. Conexion a internet: Un buen ancho de banda seréa esencial
para visualizar los videos con comodidad.

Los datos personales del autor son:
Nombre: Andrés Martin Jiménez
Fecha de Nacimiento: 20 de Mayo de 1983
Ciudad de Nacimiento: Madrid
Ciudad de Residencia: Valencia
NIF: 44519754-B
Teléfono de Contacto: 651404169
Email: anmarji@eui.upv.es
Estado Civil: Soltero

Breve resumen curricular en relacion al desarrollo del proyecto:
Diplomado como Ingeniero Técnico Informético de Sistemas con la
Especialidad de Multimedia (2005).

Beca Erasmus de un afio cursada en Turku (Finlandia) (2005).
Realizacion del Master en Produccion Artistica (2006-2007)

Becado del ITEAM (Instituto de Telecomunicaciones y Aplicaciones
Multimedia) con contrato de 6 meses para desarrollo de aplicaciones
en Colaboracién con Motorola (2006).

Actualmente cursando el Master de Ingenieria del Software en la
Facultad de Informéatica de la UPV.

Disefio de varios Websites como Freelance.
Disefio de paginas en Flash y programacion en PHP para Dualtel SL.


mailto:anmarji@eui.upv.es

PACO Y OPAC
2- Desarrollo Conceptual

Una comedia de ciencia ficcién sirve de base para la exploracion del
mundo de la animacion.

La filosofia y motivaciones de este proyecto se pueden dividir en varias
tendencias que entretejidas desembocaron en un producto bastante
completo:

Las teméticas:

o Dar vida a una historia de ciencia ficciéon. La
ciencia ficcion estd presente en cada recodo ya
que parte de una base muy similar a la de
novelas y peliculas en las que se inspira. Quiza
la mas obvia es la de Regreso al Futuro.

o Los tintes de comedia. Siendo un fan del género
tanto literario como cinematografico de la §
comedia, existe una gran inversion en la escritura del gwon
para conseguir unos dialogos refrescantes, tratando de emular
las grandes obras maestras como “Clerks” de Kevin Smith o “Le
diner de cons” de Francis Veber.

Artisticas (propiamente dichas):

o La exploracion de esa parte del mundo artistico
qgue es la animacion, el dibujo en movimiento.
Como referentes e inspiraciones se podrian citar
“Futurama” o “Los Simpsons” de Matt Groenning
0 “A Scanner Darkly” de Richard Linklater.

o La inmersiéon de una manera algo superficial en
el mundo del celuloide.

o ElI mundo del sonido, desde la creacién de efectos especiales
sonoros hasta la misma banda sonora de la serie.

Tecnologicas:

o Desarrollo de una plataforma para la publicacion del trabajo
desarrollado de una manera completa y automatizada.

o Testear la capacidad del software empleado para la realizacion
de una animacién de un formato mas largo de lo comdn, y
contemplar su resultado.

Econdmicas: crear una fuente de capital suficiente como minimo para
el mantenimiento del proyecto, en base a la publicidad, merchandising
y donaciones de los usuarios online.

Foto de Christopher Lloyd e imagen de Futurama extraidas de www.imdb.com



http://www.imdb.com/

;De qué va Paco y Opac?

Idea General de la Serie

“Paco es un chico bastante solitario pero relativamente normal, que
trabaja como programador, explotado por una empresa de desarrollo de
Software. Vive solo en un pequefio piso de la gran ciudad.

Es su veinticinco cumpleafios y compra una tarta para él solo, y su desea,
al soplar las velas, es que le ocurra algo bueno. Se va a dormir,
convencido de que su deseo no se veria cumplido; pero, a la mafana
siguiente, Paco se despierta y nota que algo no va bien. No se puede
mover y estd en una especie de sala de hospital. De repente unas
sombras se posan sobre él, dos personajes que al principio le resultan
borrosos. Poco a poco empieza a distinguir lo que resultan ser un par de
extraterrestres con batas de enfermeros. Paco asustado piensa, en una
primera instancia, que ha sido abducido pero cuando consigue mover sus
manos, descubre que su piel se ha tornado verde, como la de esos seres.

Un escalofrio de terror recorre su cuerpo ante la idea de que haya sido
objeto de experimentos alienigenos. Los médicos, al percatarse de que ha
despertado deciden llamar al responsable de su ingreso en la clinica (en
un espafol inexplicablemente comprensible para él, claro esta). Un
supuesto amigo, que dice conocerle desde la infancia va a recogerle y le
cuenta que, lo que segun Paco es la realidad, no era mas que una
simbiosis de estado comatoso y amnésico, producida por un accidente
que sufri6 hace veinticinco afios, y que ha pasado todo ese tiempo
inconsciente en la clinica. Su nombre en ese mundo es un anagrama del
gue tenia en la Tierra (pero con un toque mas “marciano”). Opac.

Paco comienza el dia en este nuevo mundo y va a adaptandose
progresivamente a él. Su nuevo amigo es simpatico, y empieza a disfrutar
de esta nueva vida que se le presenta, (aunque no todo son buenas
noticias, la que era su casa ha sido embargada por impago de la ultima
cuota hipotecaria).

Al caer la noche, cuando Paco se acuesta, vuelve a despertar en su
antigua vida, como si todo se hubiera tratado de un suefio. Este proceso
se repite dia tras dia y asi, Paco entra en un bucle del que no halla
explicacion alguna.”



LLa Animacion como medio

La animacién es dinamica, comprende dibujo, narracion, sonido, musica...

La historia que iba a servir de base —o por decirlo de una manera mas
aproximada, como liebre para la carrera de galgos que ha resultado ser
este proyecto- requeria como expresion grafica algo mas que una novela,
ya que no se habria contemplado en ella gran parte de su esencia que es
en este caso el ritmo y velocidad de la misma. Por otra parte supondria
una imposibilidad técnica, en cuanto a recursos se refiere, su realizacion
en imagen real, ya que requeriria una gran dosis de CG (Computered
Graphics) y habria que invertir tanto en la plasmacién, que se
descuidarian otros detalles mas importantes. La animacién es un medio
relativamente rapido y apto para cualquier tipo de historia, aunque
también supondria en adelante otros desafios que mencionaré mas tarde.

El estudio previo de la animacion como forma de expresién ha sido
esencial, y por ello han servido de gran apoyo asignaturas como las de
“‘Animacién. De la Idea a la Pantalla”.

La escritura del guién en base a una idea, teniendo siempre presente su
enfoque hacia un producto final definido, ha supuesto quiza el reto mas
grande del proyecto, con coste temporal enorme, debido muy
especialmente a la individualidad del proyecto —como se puede observar
en el grafico de Gantt del punto 4. Por poner un ejemplo bastante
descriptivo, la escritura de un guidon de “The Simpsons” - serie de
animacion con capitulos de una duracion aproximada de 25 minutos -
tiene una plantilla de 47 grandes escritores como guionistas.

En sintesis, el Desarrollo Conceptual se repartio en varias fases del
proyecto:

- Lacreacién de la idea base ya descrita anteriormente.

- Escritura del guién.

- Disefo de escenarios y personajes, muchas veces paralelo a la
fase anterior (tanto conceptual como graficamente).

- Técnicas de representacion gréafica (igualmente unida a la
anterior).

- Banda Sonora.

Las mismas se describen en las paginas siguientes.



2.1 - Escritura del Guién

Una buena guia para la obtencién de ciertas situaciones comicas que den
ese caracter de comedia a la linea narrativa es el esquema obtenido
mezclando los conceptos de el chiste en general, considerando ciertas
propiedades del humor ludico como:

“a) brevedad,

b) autosuficiencia semantica,

c) fijacion-reproduccion (ficcion),
d) funcion exclusivamente ludica™

O una clasificacion superficial, para hacer uso sobre la marcha de
cualquiera de las distintas formas:

- Juegos de Palabras

- Comicidad Gestual

- Humor por Repeticion
- Sentido Erético

- El Surrealismo

- El Caréacter

- Los gags situacionales
- Ocultacion

- El Absurdo

La técnica de escritura del guidon que mas cabria sefialar, y mas o menos
determinada autométicamente sobre la marcha fue la de crear una
sucesion de hitos, listados cronoldgicamente, y luego entremezclarlos,
unirlos y desarrollarlos, al principio brevemente y luego de una manera
mas prolongada incluyendo los diadlogos y dando como resultado el escrito
final.

El guion producido es un hibrido entre el guion literario (tipo novela) y el
guidn técnico (con apuntes de planos y todo lo referente a lo que va a
aparecer por pantalla).

2. Capitulo | de la obra de Ana M2 Vigara Tauste. El chiste y la comunicacion lidica:
lenguaje y praxis, Madrid, Ediciones Libertarias, 1994. Espéculo. Revista de estudios
literarios. Universidad Complutense de Madrid.

Disponible en: http://www.ucm.es/info/especulo/numero10/chiste.html



2.2 - Disefo de Escenarios y Personajes

Los Escenarios
En el disefio de escenarios habria que diferenciar las dos ramas obvias:

- Escenarios en el planeta Tierra: Un paisaje algo grisaceo como el de
una ciudad cosmopolita, algo triste, para acentuar el poco interés que
despierta al protagonista el mundo que le rodea en ese prisma.
Cuando se trata del lugar de trabajo es cuando més se denota el
carente cromatismo.

- Escenarios en el planeta Emmauksenkatu: Cabe mencionar que gran
parte del ideario del proyecto procede de experiencias personales,
como en este caso, Emmauksenkatu, nombre que toma el planeta
extraterrestre, toma su nombre de una calle de una ciudad de
Finlandia, pais inspirador tanto en las tendencias del disefio
escandinavo como por su semantica representando el Fin de Este
Mundo. El planeta extraterrestre tendrd colores alegres, paisajes
soleados. Nueva tecnologia, un semblante muy parecido al de
cualquier ciudad moderna de la Tierra, pero con naves espaciales
surcando los cielos constantemente. Recordando a “Regreso al Futuro
2", “Yo, Robot”, “Minority Report”, etc. O cualquier futuro luminoso y
calido.

Los personajes

En el desarrollo de personajes se han producido tantas variaciones como
en la historia en si. Un primer acercamiento seria Paco. Se trata de un
ingeniero informatico (valgan las referencias autobiograficas), explotado
por un maligno jefe (al mas puro estilo del Mr.
Burns) y que desolado busca una salida a su
precaria situacion. Su nombre completo Francisco
Arturo Sopena procede de Arthur Schopenhauer®,
por sus teorias oniricas obviamente implicitas en el
argumento.

Mas tarde la cosa evolucion6 en un informatico
mediocre, su jefe tampoco abusa excesivamente de
el, pero eso si, como agente antagonista se
introdujo a la Bestia, siempre mas diabdlico que el mismo diablo, que mas
anciano, se dedica Unicamente a mandar en su averno (y no disimula sus
cuernos, mientras que el hijo los repeina hacia atrds con laca); mientras
Toni, sale y se dedica a chantajear a Paco para que haga su propio
trabajo. Paco se preocupa pero no deja de ser algo apatico y distraido.
Sus compafieros de trabajo lo desencasillan de posibles pozos de
excesiva personalizacion; asi ellos se dedicaran a aportar ese caracter

% : Version del retrato de Schopenhauer con la técnica empleada en el proyecto.



Geek® mientras Paco se reserva el derecho a ser ese personaje
impersonal que se empapa de todos los demas, para asi identificarse
mejor con el espectador, reaccionando de la manera mas natural posible
a cada una de las alocadas situaciones que se le presenten.

Por su parte Jert (el compariero extraterrestre) hace las veces de Brodie
para el T.S. Paco (ver Mallrats).

Alberto, que hace referencia a Einstein, como el perro de Marty en
Regreso al Futuro, es graficamente una caricatura del Dr. Emmett L.
Brown de Regreso al Futuro. Paco haria del joven que se mete donde no
debe, aunque en este caso va a buscarle sin Doc saber nada al respecto
(mas o menos como cuando Martin le dice que ha llegado del futuro con
una maquina que €l mismo ha inventado).

La chica de la historia tiene el efecto comparativo con su compariera de
trabajo (Matilde), que perdié la pasion por la panaderia hace muchas
cajas de cruasanes y que en realidad mastica mas que habla. Ana, sin
embargo permanece timida, en la sombra para ser descubierta algun dia
por Paco de una manera mas profunda.

Mientras tanto otros muchos personajes secundarios se dedicaran a
enfatizar cada uno de los aspectos de la personalidad de Paco como la
casera, el vigilante de la universidad, el mecanico, etc.

2.3 - Técnica de Representacion Grafica

Tanto o mas importante que el conocimiento y buen uso de una técnica
determinada es la eleccién de la correcta. Los bocetos de Paco y Opac
evolucionan constantemente pasando por distintas
técnicas y probando muy distintas. Desde el dibujo
pincelado hasta el efecto plumilla.

Finalmente, en lo que se refiere al trazo y relleno, se
concret6 por un estilo cercano al del comic, con unos
bordes pronunciados identificando los objetos de una
manera algo exagerada y dando mayor sensacion de
profundidad y de
conservacion de los objetos,
ayudando asi a la animacion
final, y semanticamente muy
adecuada con respecto al
género de comedia, para
generar expresiones
caricaturescas y movimientos
muy marcados. Los rellenos
sélidos y alguna sombra
proyectada o brillo fijo, que

% Dicese de los adictos al mundo de la informatica.



hicieran facil la post-edicién con el software disponible.

Al principio los personajes eran bajitos y cabezones, (el estilo llamado
“SuperDeformed”), pero evolucionaron a unas proporciones mas normales
para dar mas juego a la animacién y permitir dirigirlo a un publico
relativamente adulto.

2.4 — Banda Sonora

La banda sonora de la serie estad inspirada en la banda sonora de
Futurama, a su vez basada en la “Psyché Rock” de Pierre Henry (1967).
Un sonido electronico muy apropiado para una serie en la que apareceran
artilugios electrénicos de todo tipo, y muy futuristas cuando se trate del
planeta extraterrestre. Ademas de este aire “electrénico” al mismo tiempo
debe resultar comico.



PACO Y OPAC

3- Descripcion Técnica y Tecnolégica

3.1 - Analisis de Recursos Materiales

Los recursos materiales se pueden dividir en dos subclases: los medios
tradicionales y los digitales.

Medios Digitales

A primera vista pareceria mas logico empezar por los medios
tradicionales, pero el primer contacto con el proyecto en si tuvo lugar con
un procesador de texto (Open Office).

Escritura de la idea base, el guion, descripciones:

o Hardware: Definiremos las componentes mas adelante
debido a limitaciones.

o Software: Open Office (gratuito).

Busqueda de Informacion, contraste de referencias en el
guién: Navegador Web (gratuito) y conexion a Internet.

Disefio de personajes, Animacion, Produccién Web:
o Hardware:

= Equipo de sobremesa, torre y monitor (19’), con el
siguiente minimo de requerimientos: Procesador
1GHz Pentium 4 o AMD K7, 1 Gigabyte de RAM
DDR2, tarjeta grafica 256 DDR, Disco Duro de 50
GB, Altavoces 2.1 o Auriculares “Maxi”.

= Scanner.
» Tableta Digital Wacom (minimo A-5).

Adicionalmente para usar algo de rotoscopia, haria falta
algun dispositivo de grabacién de video de bajo coste.

o Software:
=  Adobe Flash.
= Adobe Photoshop.

» Software de Edicion de Video, por ejemplo Adobe
Premiere.

= Software de Edicién de Audio, por ejemplo Adobe
Audition.
» Fruity Loops: para la creacién de la banda sonora.



Asi tenemos que con la Suite Completa de Adobe Creative,
podriamos tener aproximadamente todo lo necesario en lo
gue se refiere a Software de pago.

Medios Tradicionales

- Lapiz, gomay papel.
- Plantilla de StoryBoard.

El uso de mesas de dibujo tradicionales (con luz retro-proyectada) no es
necesario pues el software de animacion reproduce el mismo efecto con
“papel cebolla”.

3.2 - La Técnica y Fases del Proyecto

a) Guién del Capitulo Piloto

Como he descrito en el punto de Desarrollo Conceptual, puesto que en
parte eso es el guidn de la historia, la técnica para la escritura del mismo
se baso en el primer desarrollo de la idea general, y posterior desarrollo
por puntos. Una buena diferenciacion de las fases que tuvieron lugar en el
desarrollo evolutivo de la escritura del guién seria la siguiente:

1. Historia general: Descripcion completa de la historia en el capitulo
piloto.

2. Hitos: Distribuciéon de cada elemento en la linea de tiempo que
marcara el ritmo y evolucién argumental.

3. Interconexiones: Enlaces entre cada capitulo, pasos hacia delante
y hacia atras en la historia.

4. Desarrollo: Explicacién mas extensa de cada uno de los hitos en la
historia.

5. Dialogos.

b) Disefio de Personajes vy Escenarios

El primer paso para el disefio de los personajes son los bocetos, a lapiz
sobre papel coman. Tras muchas pruebas, hay que realizar la carta del
personaje, donde se mostrara al mismo desde distintos angulos y poses
caracteristicas. Esta carta pasara por una fase de adquisicion digital, con
el scanner. Una resolucién de 150dpi® es méas que suficiente. En Adobe
Photoshop habra que navegar por el menu “File > Import”, y seleccionar

> “dots per inch”: (en espaiiol ppp) usado en aplicaciones informaticas, que viene a ser la cantidad
de puntos —o pixeles- por pulgada que registrara el scanner a la hora de capturar la imagen.



la via de entrada que se corresponda con el scanner instalado en el
equipo.

Una vez escaneada la imagen, se puede guardar en formato JPEG (tipo
de archivo de imagen comprimida en tipo de compresion lossy — con
pérdida — que se puede configurar de Opriones de imagen

forma que la pérdida sea casi | cyga [ [wes -
imperceptible), para que asi su a,chme gmde
almacenamiento no requiera un tamafio 0

excesivo.

La imagen sera posteriormente importada en un nuevo archivo Flash, un
tamafio adecuado para una carta de personaje podria ser de 1191x842
pixeles, que viene a ser un tamafio A-3 horizontal a 72dpi. La manera de
hacerlo sera a través del menu “File > Import > Import To Stage” y
seleccionar el archivo correspondiente con extension “.jpg” del menu
contextual.

c) El timing

Para hacerse una idea de la longitud del guién y la adecuacion al formato
de capitulo determinado, es imprescindible una lectura del guién. Sera asi
mismo necesario introducir las pausas, y a ser posible los efectos sonoros
0 banda sonora necesarios. Es de bastante ayuda tener el audio final
antes de ponerse a animar, aunque en un proceso acelerado para su
produccién a corto plazo se realizar4 gran parte del trabajo en paralelo,
distribuyéndolo en escenas, que se escribiran, doblaran, dibujaran y
animaran por separado.

- Grabacion de Audio

Para la grabacion del audio del proyecto bajo el Software Adobe Audition,
habria que crear un nuevo proyecto. Este programa nos permite grabar en
distintas pistas de audio los diferentes dialogos, efectos de sonido o
musica que se deban mezclar en la banda sonora.

Para la grabacion de los dialogos habra que dar las explicaciones
necesarias de entonacion y de semantica de la historia, asi como las
descripciones de los personajes para que puedan amoldarse a su papel.
La grabacién por separado de las voces sera util para la posterior
eliminacion de ruidos y post-edicion con los efectos de sonido necesarios.
La grabacion de efectos especiales de audio se puede realizar facilmente
de un modo casero con herramientas cotidianas, y existen varios
manuales al respecto. Aunque parezca algo muy rudimentario, habria que
sefalar que las compaifiias profesionales de efectos especiales de audio,
como la del juego de Heavenly Sword de Sony PlayStation 3, usan todo
tipo de objetos obtenidos de rastros y productos alimentarios, como



muestra el Making Of° del juego. Un ejemplo que se mostraba en dicho
documental es la simulacién de roturas de huesos y ligamentos
retorciendo tallos de apio.

Yo IW
Fan 0 |
=%

Track 2 R |_|T
Fan O gl
=

- Banda Sonora

Para la composicién de la banda sonora, se ha utilizado un software de
sintesis de audio desarrollado en Delphi® y que esta basado en patrones
llamado FL Studio (Fruity Loops Studio). Este programa nos permite
componer temas musicales mediante la creacion de un proyecto, en el
gque usaremos patrones con sonidos creados digitalmente mediante
secuenciadores®. Estos patrones seran unidos en nuestro Playlist'® donde
podremos escuchar nuestro resultado final.

Para crear la banda sonora lo primero que habria que hacer es crear
nuestros sonidos, FL Studio viene con una libreria de sonidos incluidos
los cuales podemos modificar para que queden a nuestra medida. Los
sonidos a usar, dada la descripcién introducida en el desarrollo
conceptual, fueron realizados mediante uso de sonidos de campanas
empleando efectos como deelays™*

La melodia se compuso mediante el
Piano Roll que nos ofrece la creacion
de melodias mediante el uso de un
piano donde indicaremos el tono de
las notas que queramos.

Una vez conseguida la melodia, habria que acompafiar con una base,
para ello crearemos una caja de ritmo en un patrén donde usamos Kicks*?
y Hats™ para realizarlo.

®: Del inglés “Cémo se hizo”.

7: Captura de la linea de tiempo con sus correspondientes ondas sonoras del Software Adobe
Audition.

8 Delphi: Un lenguaje de programacion de aplicaciones.

° Elemento electrénico para la creacion de sonidos.

19 ista de Reproduccion.

1 Ecos.

12y 13 Sonidos del bombo y la caja de una baterfa (ya sea electrénica o tradicional).



Tras la melodia y la base, solo faltaba juntar estos patrones en el Playlist
para ver nuestro resultado, tras escucharlo es cuando se pasa a introducir
elementos secundarios (como beeps: pitidos) para conseguir que la
masica transmita lo que debe y obtener asi el resultado final.

d) El Entintado Digital

La imagen aparecera en el fondo en la capa

P . p e = &8
base de la linea de tiempo. Lo mas practico -
es bloquear esa capa y crear una superior . ™ 7 B
sobre la que crear el dibujo final. No _ W capabase + a0

utilizaremos la linea de tiempo mas alla de la creacion de nuevas capas,
puesto que estamos disefiando una imagen estatica. Aqui entra en juego

la tableta digital. Seleccionando la herramienta “lapiz” y con un

trazado suavizado (el ajustado que aparece por defecto lo convierte
en demasiado poligonal, y en tinta afectan mucho los saltos que se <
puedan producir en la captura) que esta representado por una curva
vertical, primero se realizaria el contorno externo del personaje (o incluso
alguna extremidad que se encuentre en un plano mas cercano a la
‘camara”, como se viene haciendo en el entintado de comic) colocando un
grosor aproximado de 2 puntos.

Fl

i « [50lid .| Para las lineas interiores del dibujo

se puede usar un grosor de 1 punto
o hairline (linea de cabello, tiene la cualidad de que, si creas un simbolo
como un clip embebido en la pelicula, y le cambias el tamafio al objeto -en
inglés “resize”, es muy utilizado en la terminologia del programa-, este
trazo no varia en grosor, mientras que el resto aumenta o disminuye
proporcionalmente con el objeto).

Si alguna linea parece demasiado retorcida o poco uniforme se
puede suavizar seleccionando la herramienta “flecha negra” vy &
haciendo click en el icono de suavizar que aparece abajo en la barra de
herramientas con la misma forma que el suavizado de lapiz. Y en caso de
N requerir mayor exactitud se pueden incluso controlar la posicién de
los puntos de apoyo de las curvas Bézier con la herramienta “flecha
blanca” (se pueden representar curvas de cuadraticas e incluso cubicas),
una de las muchas ventajas de usar un software con graficos vectoriales.

El relleno se hara con el bote de pintura, y una vez finalizado el X
dibujo se puede eliminar la capa de fondo, para dejar unicamente

el dibujo acabado. Adicionalmente se pueden agregar sombras de una
manera bastante sencilla creando una nueva linea (aconsejo hacerla de
otro color para poder seleccionarla distintamente a las otras haciendo




doble click sobre ella y borrarla con mayor facilidad) seccionando

el sdlido en si por la zona donde se produzca el contraste y

rellenando el interior de esa subdivision del objeto con un relleno
I*l ligeramente mas oscuro (o0 mas claro para hacer los brillos) que se

puede conseguir rapidamente desde el panel de color del
programa.

e) Plot / StoryBoard

El Guion Grafico de Paco y Opac esta a mitad de camino entre un Plot y
un StoryBoard, tiene algunos dibujos muy abocetados, anotaciones de
como se va a reproducir por pantalla asi como varios instantes de un
mismo plano en algunos casos. En animacion el StoryBoard es algo muy
variable, dependiendo del proceso, el equipo y un gran numero de
factores que intervendran en la posterior correcta o incorrecta utilizacion
del mismo. Si el animador es el mismo que el dibujante del StoryBoard no
supone un gran problema el marcado, con lo que en Paco y Opac, a
pesar de contener bastante ayuda explicativa, contiene ciertas licencias,
aunque intentandose ajustar lo maximo posible al estdndar comercial de
StoryBoard.

Con un equipo de animacién, en el caso de su realizaciébn comercial
habria que tener en cuenta las indicaciones del estandar mayormente
admitido a nivel profesional, una buena guia es el libro "Manual para la
realizacion de Storyboards”, de Raul Gonzalez Monaj
de la Universidad Politécnica de Valencia. Una de las cosas a mencionar
sobre este maravilloso libro es que se hacen valoraciones numéricas en
base al nimero de planos que se deberian extraer aproximadamente de
cada péagina de Guibén Técnico, de 8 a 10 planos por pagina es la media
sugerida (con un tipo de letra Arial de 10 puntos). Hay que decir que esto
es muy variable, como ejemplo de la experiencia de Paco y Opac, se
corresponden unos 14 -15 planos por cada pagina de Guién técnico, pero
se debe a que el ritmo narrativo del guién es vertiginoso.

El motivo de esta disertacion, es que es muy importante darse cuenta de
lo importante que es la particion en la animacién. Cada cosa ha de saber
dividirse en otras muchas creando infinitos arboles de procesos, y la
recomposicion de los mismos, tanto en la escritura del guién, como en el
StoryBoard, como en la animacion donde hay que saber dividir los
movimientos en fases introduciendo fotogramas clave... es curioso como
este proceso de division se repite una y otra vez durante todo el proceso,
y como el resultado final dependera de nuestra destreza a la hora de
realizarlo correctamente.



f) Automatizacion

Tras finalizar la fase de dibujo del StoryBoard, para registrar el StoryBoard
y poder realizar la animatica, habra que escanear todas las hojas, y de
ellas guardar cada vifleta por separado para poder importarla en el
programa donde se secuenciara. Para evitar el largo y tedioso trabajo de
repetir esa operacion para cada hoja de StoryBoard se han de usar las
acciones programables de Photoshop.

Para mostrar el panel correspondiente para dicha tarea, navegar por el
menu “Ventana (window) > Acciones (actions)”. En la ventana de acciones
apareceran diversas acciones por defecto. El procedimiento de captura de
las acciones convenientes para ser reproducidas a posteriori es crear una
nueva accion (al) y grabar (@) la ejecucién de cada uno de los pasos
gue se repetiran en cada iteracion.

Una vez grabado el proceso, y puesto que se ha usado una plantilla para
el dibujo, se puede repetir el recorte de las vifietas en las mismas
posiciones, asi como el guardado en carpetas. Dependiendo de la
capacidad del equipo informatico seria aconsejable ir administrandolo en
carpetas, y hacer un guardado general, puesto que la cantidad de
documentos abiertos puede resultar en una carga muy grande para el
programa y podria producirse algun fallo por falta de recursos.

En el mismo proceso de captura, 0 como una accion posterior sobre el
conjunto de capturas, es posible asignar efectos de aumento de contraste
en consideracion de que la visibilidad del trazo de lapiz es insuficiente.

a) La Animética

Haciendo uso del mismo software que se usara para la animacion final, se
introduciran todas las imagenes de cada vifieta de StoryBoard (de cada
escena producida por la fase de automatizacién) en la capa por defecto.
Después habra que seleccionarlos todos “CTRL + A” y “Click Derecho /
Edition > Separate Layers” que separara en capas todas las vifietas por el
orden que se muestren. Con el mismo Audition recortaremos el audio
correspondiente a dicha escena del timing final. Asi nos quedara un plano
en cada capa y ahora so6lo habra que ir arrastrandolos de forma que se
correspondan con el audio. Importaremos el audio arrastrandolo a la
biblioteca o “File > Import” (Archivo > Importar), seleccionando una capa
gue crearemos Unicamente para el audio, y en la ventana de propiedades
seleccionaremos el archivo correspondiente junto con el modo de
reproduccién Stream™®. Este formato de reproduccién se reproduce junto
con cada frame™ de la escena correspondiente. El contrario es el tipo
Event (evento), comienza a reproducirse en el momento exacto que

1 Stream: Flujo.
> Frame: Forma inglesa, usada de forma comdn , de Fotograma.



aparezca y acaba cuando acabe el audio, independientemente de la
escena. El tipo Event nos sera util por si olvidamos un efecto de sonido y
gueremos afiadirlo directamente sobre el trozo de animatica, al afadirlo
como Evento, en una nueva capa, consumira menos recursos.
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Una vez hayamos colocado todos de forma que aparezcan
secuencialmente y en su instante de tiempo correspondiente podemos
aplicar sobre ellos algunos efectos basicos como serian los movimientos
de camara: zooms, panoramicas, barridos, etc., o Fades Iny Out'®.

Una vez terminada la edicion de la animética, se puede exportar como
archivo de video. Con todos los trozos de video se pueden unir con
Premiere para obtener el resultado final de la animatica, que da una idea
muy clara de lo que sera la animacion final.

h) Animacién Final

Ya realizado todo el trabajo previo, viene la parte, a mi juicio, mas
mecénica de todas. La animacion final viene a constituir una interpolacion
entre los key frames'’ y su buena realizacién dependera de la fluidez,
aceleracion y deceleracion de los movimientos, todo enfocado a mostrar
la mayor naturalidad posible en los mismos. Para ello Flash nos ayuda
con multiples herramientas, de las cuéles me gustaria destacar por su
enorme grado de utilidad las siguientes:

- '@ Onion Skin (papel cebolla) y ‘@ Onion Skin Outlines (contornos de
papel cebolla): Esta herramienta viene a ser la mesa de luz de Flash.
Muestra el contenido de los frames contiguos en la misma capa que se
esté editando para la linea de tiempo, de tal forma que los mas cercanos
tendran una mayor opacidad mientras que los mas lejanos seran casi
transparentes. Los que estén por delante en la linea de tiempo
apareceran delante. El Onion Skin Outlines tiene un efecto parecido, pero
s6lo mostrara los contornos de los rellenos o las lineas (en caso de
haberlas) que se encuentren en los frames contiguos. Los marcadores

16 Fade In y Fade Out: Fade es un recurso audiovisual que genera una transicion de la imagen o
video mostrados a otra imagen o video o a un color concreto (normalmente blanco o negro). El In
seria el de entrada (de negro a la imagen) y el Out de salida (de la imagen al negro). También se
usa como efecto de audio, atenuando o aumentando el sonido paulatinamente, su uso para el
Timing también es bastante practico. Ademas suelen sincronizarse los Fades de audio y los de
video.

17 Key Frames: Fotogramas clave, en este caso se refiere a cada fotograma que se selecciona para
mostrar un cambio significativo en un plano o un cambio de plano.



negros representados como corchetes negros son desplazables para asi
mostrar la zona que nos interese tener como referencia. En el ejemplo de
abajo se pueden ver la edicion del final y del comienzo de la transicion
con Onion Skin vy la edicion de un frame intermedio con Onion Skin
Outlines respectivamente. El frame seleccionado se identifica por ser el
marcado en la linea de tiempo por la linea roja. %
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- 1 Edit Multiple Frames (Editar multiples fotogramas): Si tras dibujar una
larga sucesion de frames correspondientes a un movimiento de un
personaje nos diésemos cuenta de que no esta en la posicion correcta, o
que las proporciones no son las que deberian, podria solucionarse
igualmente gracias a esta herramienta, que con una forma de seleccion
de frames similar a la anteriormente mencionada (salvo que esta no
mostrara transparencia) nos permite seleccionar multiples frames al
mismo tiempo y editarlos de todas las maneras posibles, incluyendo pues
cosas como cambios de posicién y transformacién libre (de las mas
utiles), de color, etc.

Para cambiar la velocidad de reproduccion por defecto habra que acceder
a “Modify > Document > Frame Rate”. Puesto que Flash esta muy
orientado a Web, la velocidad de reproduccién es de 12 fps'®, lo cual
puede quedarse corto si se trata de una animacién cuidada que incluya
panoramicas 0 zooms de escenarios mas 0 menos complejos. En este
proyecto la velocidad seleccionada ha sido de 20fps, aunque 15fps suele
ser suficiente para realizar una animacion aceptable.

Una vez finalizada la edicién de la animacion, si se trata de una animacion
complicada (como en este proyecto) puede que la maquina virtual en la
gue se apoya Flash no aguante con la cantidad de poligonos y trazados
por segundo que debe mostrar para reproducirse a un ritmo visual de la
velocidad seleccionada. EI mecanismo de reproduccion puede ser el
siguiente: se exporta como un video, el cual se puede editar
posteriormente y agregar efectos con After Effects o cualquier

'8 Fps: Frames per second (fotogramas por segundo, afortunadamente las siglas coinciden).



herramienta de edicion de video semejante pues ya habremos dejado el
terreno de los graficos vectoriales para adentrarnos en una reproduccion
de imagen comprimida. La forma de reproducir el video final para que se
realice de una manera eficiente se explicara en el siguiente punto.

i) Rotoscopia

Existen movimientos muy complicados que son realmente dificiles de
reproducir con verdadera fluidez en el tiempo. Para casos como este
existe la posibilidad de realizar una rotoscopia de una manera muy
sencilla con Flash. En el proyecto se realizo la rotoscopia con respecto al
movimiento del tronco superior en un caminado frontal.

Lo primero sera adquirir el video de imagen real con una camara (incluso
una webcam o camara de fotos digital nos valdria, ya que la calidad de la
imagen no es lo importante sino una captura general del movimiento).
Para la captura se puede usar cualquier software, incluso el Windows
Movie Maker que trae Windows por defecto, o como el Avid que es de
caracter freeware'®. Una vez guardado el video en un fichero, este fichero
se importara desde flash como video embebido en la linea de tiempo
(Flash ofrece varias alternativas para la importacion de video, como
Streaming®, que utilizaremos en la web, y semejantes). Asi se podra
disponer de él en una capa inferior y dibujar el movimiento encima
tomandolo como referencia.

i) Integracion Web

Una vez tenemos tanto material dentro de Flash, la integracion del mismo
en la web es bastante sencillo, s6lo hay que introducir los elementos
necesarios y aportar la interactividad necesaria para navegar por ellos.

La manera de crear una web con flash es la misma que para una
animacién, habra que crear un nuevo documento, y en este caso vamos a
fijar un tamafno de documento mas grande en “Modify > Document >
Size”. Al tratarse de una pagina web que esta destinada a reproducirse en
un navegador estandar de un ordenador personal el tamafio por defecto
de flash de 550x400 parece excesivamente pequefio (aunque podria
haberse creado en base a una plantilla web, pero vamos a realizar el
proceso desde cero). Segln la W3Schools?, la cantidad de usuarios que
usa una resolucion mayor o igual a 1024x768 es del 80%, frente a un 14%
gue usa una menor y un 6% desconocido. Es de suponer por tanto que
una web de un tamafio de 1000x700 sera mas que adecuado para una
buena visualizacion en un ordenador.

9 Tipo de licencia Software que protege los derechos del autor, pero destinada a software gratuito.
? Tipo de descarga de informacion que supone el poder reproducirla al mismo tiempo que baja.

2! http://www.w3schools.com/ famosa web de estandares web. Los datos referidos son de Enero de
2007.



http://www.w3schools.com/

Una vez definido el tamafio apropiado habra que colocar los elementos de
forma que sea facilmente explorable. Un menu claro y bien definido sera
crucial para ello.

Para crear un boton en Flash basta con crear
un simbolo botén, y al explorarlo (con doble
click) podremos ver en su interior, su disefio
para cada estado del boton: reposo (up),
encima (over), click (down); ademas de otro -

afiadido que definira la zona de accion del +

boton (hit). Si no se pusiese nada en la zona O
de hit tomaria como referencia la forma del

boton.
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Una vez afiadido el boton, viene la parte importante, que es la de dotarlo
de unas acciones a realizar. Durante el desarrollo del proyecto se dio la
aparicion de una nueva version de Flash (la CS3) lo que me indujo a
migrar el codigo original de una versién ActionScript?? 2.0 a una 3.0. Asi
gue explicaré las dos maneras de hacerlo:

- Javascript 2.0: Con 2.0 la forma de hacerlo era muy sencilla. Una vez
creado un botén (Insertar > Simbolo >Botdn), se colocaba en alguna capa
y seleccionaba el mismo. Luego se mostraba el panel de opciones y se
escribia el siguiente codigo:

on(release){
/*Y aqui las instrucciones necesarias. */

Esto hacia que cuando se produjera el evento “release” que es el de
soltar el click del ratén después de hacer click, se ejecutase el codigo
deseado, por ejemplo gotoAndPlay(3) que haria que la reproduccion del
clip pasase al frame numero 3.

- Javascript 3.0: La forma de hacerlo con 3.0 es menos intuitiva pero
resuelve algunas inconsistencias del lenguaje de programacion (a primera
vista ya se ve claramente que la depuracion de los programas es
infinitamente mas eficiente). Una vez creado el botdbn habra que
seleccionar un key frame de la linea de tiempo desde el cual aplicar un
Listener (escuchador, un proceso que se percatara de los eventos que
produzca el botén).

22 Se trata del lenguaje que usa Flash para definir cualquier tipo de programacion en un Clip de
Flash. Esta basado en Javascript y tiene es de facil manejo, su paradigma es el de Programacién
Orientada a Objetos (POO).



El codigo tendra la forma siguiente:

function hacer_click(e:Event {
[* Y aqui las instrucciones necesarias. */

}
mi_boton.addEventListener(MouseEvent. RELEASE, hacer_click);

Donde “mi_boton” sera el nombre dado a la instancia del boton, y
“hacer_click” la funcién que se ejecutara cuando el evento RELEASE se
produzca.
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4- Proceso de Trabajo

Existen dos visiones respecto al proyecto realizado, una vision individual,
como proyecto de autor, con un tiempo de realizacion muy grande y sin
posibilidad de rentabilidad econdmica. Y una visibn comercial, Como
proyecto de equipo con un tiempo de realizacion muy reducido y con
vistas a generar beneficios. Obviamente a nosotros nos interesa la vision
comercial, pues la idea del proyecto es llevarlo a un planteamiento de
produccion profesional real.

Esta vision comercial se plantearia como una temporada completa de 20
capitulos cuya realizacion tendria lugar a lo largo de un afo laboral. Cada
capitulo se desglosara por separado en su propio diagrama temporal pero
se solaparan en la vista global para sacar el mayor partido a los recursos.
Se utilizara el Calendario Laboral de la Comunidad Valenciana para el
afio 2008 segun datos oficiales®.

El diagrama de Gantt resumido para la Temporada Completa seria el
siguiente:

Mombre de tares tri 1, 2005 tri 2, 2008 tri 3, 2005 tri 4, 2008

ene | feb [ mar abt [ may [ jun [ mmn | zep ot | mav | dic

| Capitulo 1 pe—
Capitulo 2
Capitulo 3
Capitulo 4
Capitulo 5
Capitulo 6
Capitulo T
Capitulo 8
Capitulo
Capitulo 10
Capitulo 11
Capitule 12 =y
Capitulo 13 —
Capitulo 14
Capituloe 15
Capitulo 16
Capitulo 17
Capitule 18

Capitulo 19 ;
Capitulo 20

Quedando el mes de Agosto inhabil a todos los efectos.

% Los datos oficiales son los siguientes:

- La Resolucion de 9 de octubre de 2007, de la Direccion General de Trabajo, por la que se publica
la relacién de fiestas laborales para el afio 2008 (BOE del 20, IL 5308).

Disponible en: http://www.boe.es/boe/dias/2007/10/20/pdfs/A42708-42709.pdf

- El Decreto 151/2007, de 14 de septiembre, por el que se determina el calendario laboral de
aplicacion en el ambito territorial de la Comunitat VValenciana para el afio 2008 (DOGV 17/9/2007,
IL 4681/2007). Disponible en: http://www.gva.es/c_economia/web/hacienda/calendario-2008.pdf



http://www.boe.es/boe/dias/2007/10/20/pdfs/A42708-42709.pdf
http://www.gva.es/c_economia/web/hacienda/calendario-2008.pdf

Para los recursos humanos se han administrado las tareas, en base al
esfuerzo en horas, basado en la propia experiencia del proyecto:

- Guién 160h

- Disefio 60h

- Audio 60h

- Storyboard 240h

- Animacion Final 500h

- Actores Doblaje (10 actores) 48h

Para repartir el trabajo en los 10 dias laborables entre capitulo y capitulo
(ya que hago la estimacion de 1 capitulo cada dos semanas), calculamos
en funcién de la necesidad de recursos y dinamica del trabajo:

- Guién 160 horas = 4 guionistas * 10 dias * 4h diarias.
(4 guionistas - 400% de recursos - * ¥ de la jornada completa =
200% en el diagrama de Gantt para 10 dias)

- Disefio 60 horas = 2 Artistas Conceptuales * 10 dias * 3 h
diarias.

(2 AC — 200% de recursos - * 3/8 de la jornada completa = 75% de
recursos en Gantt para 10 dias)

- Audio 60 horas = 2 Técnicos de Audio * 10 dias * 3 horas
diarias.

(2 TA — 200% de recursos - * 3/8 de la jornada completa = 75% de
recursos en Diagrama de Gantt para 10 dias)

- Story 240 horas = 6 dibujantes * 10 dias * 4h diarias.
(6 dibujantes - 600% de recursos - * % de la jornada completa =
300% en el Diagrama de Gantt para 10 dias)

- Animacién 400 horas = 10 animadores * 10 dias * 4 horas
diarias.

(10 animadores — 1000% de recursos — * % jornada = 500% en el
Diagrama de Gantt para 10 dias)

- Actores 100h = 10 actores de doblaje * 5 dias * ~ 2h al dia
[suele tratarse de grupos propios, asi que se pueden contabilizar
en los dias necesarios, que se corresponderan con dias de trabajo
los técnicos de audio para poder grabar las voces, y que coincidira
con ellos en las horas de trabajo] (1000% * 2/8 = 250% de Gantt
para 5 dias)



Dejando un diagrama de Gantt para el primer capitulo como el siguiente:

Mombre de tarea

| emero 2008

| febrero 2008

30 |02 [ o5 [ o8 [ 11 [ 14 [ 17 [ 20 [ 25 [ 26 [ 289 | o1 [ o4 [ o7 [ 10 [ 13

= Capitulo
Guian
Digefio
Storyboard
Ao
Dohlaje
Animacion

Guionista (h/dia)[200%]

Artista Conceptual {3I1.-'(Iia)['.”."in°a’o]
e {4hidia)[300%]

e Ao b

ctor Doblaje (Pag?o por capitulo)[250%:]

Tédi:nico Sonido (3hidia)[T5%]

Disefiador Veb

1 Animador Flash {3#hidia)[500%:]
E Disefiador Web (2himes)

Se puede observar en el diagrama que el primer capitulo tardaria un mes
en realizarse; se trata del desfase producido por la dependencia de unas
tareas con otras, no se puede comenzar el diseiio de escenarios y
personajes hasta que no se conozcan estos en el guién, no se puede
comenzar a animar si no hay nada de Storyboard, etc. En realidad este
efecto de desfase sélo ocurriria con el primer capitulo, ya que el solape de
los capitulos al haber normalizado el tiempo de trabajo a 10 dias laborales
haria que no hubiese problemas posteriores para editar un capitulo cada
15 dias.

Esto implicaria que el contrato para el Guionista comenzaria el 2 de Enero
de 2008, el del Artista conceptual el 4, y asi sucesivamente. Y a partir de
ahi todos renovarian mensualmente sin problemas, trabajando a razén de
2 capitulos al mes aproximadamente, salvo los contratos por obra y
servicio como el de los dobladores o el del administrador de la web.

24

Informe del resumen de trabajo de los
recursos

m Disponibilidad trabajo Trabajo  m Disponibilidad restante  ® Trabajo real

2000
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Trabajo

Técnico
Sonido
(3h/dia)

Guionista
(4h/dia)

Disefiador
Web
(2h/mes)

Artista

Conceptual
(3h/dia)

Animador
Flash
(4h/dia)

Dibujante
(4h/dia)

Trabajo

24 Gréfico generado con Microsoft Project



PACO Y OPAC

5- Dibujos Constructivos

5.1 - Bocetos Personajes
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5.2 - Bocetos Escenarios




5.3 - StoryBoard
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6- Render

6.1 Video

Frame 140; 6.9 segundos Frame 156; 7.8 segundos



Frame 172; 8.6 segundos Frame 196; 9.8 segundos

\
Frame 348; 17.4 segundos Frame 388; 19.4 segundos



6.2 Cartas de Personajes




6.3 Escenarios
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7- Presupuesto

Inversion Inicial

Hardware:
11 equipos
(10 conectados
a un servidor
para guardar el
trabajo
avanzado)

Software: Todo
lo necesario.

Alquiler del
Piso (unos
100m?)

Mobiliario

10 de Usuario:

Torre + Accesorios Basicos y SO® 500 €,
Monitor 200 €,

Tableta Digital Wacom 200 €

Total Parcial 900 €

1 de servidor:
Solo la torre: 500 €
Router + Cable de Red: 100 €

Multifuncion (Scanner + Impresora +
Fotocopiadora) de caracter profesional

5 Scanner : 80 €

Fl Studio Express: 50 €
Adobe Creative Suite 3 Master Collection:
3.000 €

Fianza: 1.500 €

10 Mesas de Dibujo (150€),
10 de Ordenador (80€), 20 Sillas (50€)
Armario (400€)

Total Inversion Inicial

% Sistema Operativo

9.000 €

600€

900 €
400€

3.050€

1.500€

2.700€

18.150€



Mensual/Total

Suponiendo un coste (incluidos gastos sociales) para los trabajadores
como el que sigue:

- Artista Conceptual: 17,50 €/h
- Guionista: 20,00 €/h
- Dibujante: 15,00 €/h
- Actor Doblaje: 25,00 €/h
- Técnico Sonido: 17,50 €/h
- Animador Flash: 20,00 €/h
- Diseflador Web: 20,00 €/h

El flujo de gastos del primer capitulo seria el siguiente:

211207 07aime 140108 210108 2840108 Total
Capitulo
Guién Q60,00 € 1.600,00 € 40,00 € 2.200,00 £
Disefo a0,00£ 450,00 € 360,00 € a00.,00 €
Storyboard 1.440,00 £ 1.200,00 € 360,00 € 2.600,00 £
Audio 315,00 € 526,00 € 210,00 € 1.050,00 €
Doblaje 1.500,00 € 1.000,00 € 2.4500,00 £
Animacian 1.600,00 € 4.000,00 € 4.000,00 € 320000 € 12.800,00 €
Dizefiador Web 40,00 € 40.00€
Total 1.050,00 € 5.090,00 € g.615,00 € 5.885,00 € 345000 € z4.090,00 €

Esto, unido al alquiler y gastos de vivienda (que ascenderian
aproximadamente a unos 800 euros de alquiler y 200 de gastos) resultaria
en un total de (dado que por cada mes se podrian producir a la larga una
media de dos capitulos): un Coste Mensual de 49.050 € / mes.

El coste real de una temporada completa de 20 capitulos sera pues de:

Inversion Inicial 18.150€
Coste Capitulos: 20 x 24.090 € 264.990 €
Alquiler 11 meses 11.000€

Coste Total del Proyecto 294 .140€
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8- Conclusiones

En general este ha sido un proyecto muy ambicioso llevado a cabo con
determinacion y mucho esfuerzo si damos un repaso a los logros:

e |dea general de la Serie: Pautas generales, conceptos definidos.
e Guién completo del Capitulo Piloto.

e Disefio de personajes y escenarios.

e StoryBoard (300 hojas de 3 planos = 900 planos).

¢ Animatica de 30 minutos con efectos de sonido.

e Demo de 25 segundos con resultados finales.

e Banda Sonora de la serie.

e Web para su reproduccion.

No es de extrafiar que esté bastante satisfecho por los resultados. Creo
que se trata de una apuesta arriesgada que quiza no podria realizarse sin
una inversion previa por parte de alguna empresa privada interesada,
pero que sin duda se hace posible gracias al planteamiento, plan y
estructura del proyecto.

En Internet nunca se ha apostado por un tipo de animacion tan elaborado,
reduciéndose, en general, a mini-series comicas del estilo de Calico
Electrénico, (que sigo como fan) que si bien cumplen su funcion, también
se echa de menos algo de realismo o un cambio de estilo (no reducirlo
siempre a retratos caricaturescos), o insuflar algo mas de argumento a
sus lineas narrativas. Asi mismo el humor en Espafia suele reducirse al
chiste facil en entornos muy cerrados, haciendo que sus posibilidades (de
llegada al publico) sélo tengan un caracter local. Muy lejos de ser una
gran obra, el guién de Paco y Opac ha tratado de centrarse en un humor
mas situacional, pues ante todo lo sustenta una historia.

Desde un punto de vista intimo, nunca habia ahondado tanto en una idea
y, esto supone gue, a parte de una tesis de master como tal, se haya
dado la concepcion de una entidad real, independientemente del hecho
de que se termine o0 no de realizar, se ha dado vida a Paco y Opac, y eso
es, sin duda, todo lo que se le puede pedir a un proyecto personal.

Desde el punto de vista de las dificultades del proyecto, creo que han sido
llevadas con soltura y gran dosis de tenacidad para abordar un proyecto
de tal envergadura. Existia mucha abstraccion en un principio, y queria
obtener resultados practicos y estoy seguro de haberlos logrado en buena
parte gracias a la gran labor de orientacion de mi directora del proyecto.
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